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Artec Studio Photogrammetry

Vanaf Artec Studio 19 kunnen gebruikers nu 3D-modellen 

reconstrueren op basis van sets foto’s en video’s.

Voordat u begint

Het is sterk aan te bevelen om 

het Neural Network te activeren 

voordat je begint en deze in te 

stellen tijdens de eerste keer 

opstarten van Artec Studio. Je 

kunt dit doen in Settings (zie 

afbeelding). Belangrijk: sla deze 

stap niet over.

Een uitgebreide beschrijving van 

de volledige functionaliteit is te 

vinden in de Engelstalige handleiding die tijdens de installatie 

van Artec Studio op de computer wordt geïnstalleerd. Deze 

kun je openen met CTRL-F1. We raden je ten zeerste aan om 

hier de tijd voor te nemen en vooral de praktische tips goed 

door te lezen.

Soorten Photogrammetry-algoritmes 

Het gebruik van Photogrammetry in Artec Studio bestaat uit 

twee opeenvolgende acties:  

Stap 1.

Bereken de Preview 

Wanneer er een set foto’s in Artec Studio is geïmporteerd, dan 

wordt deze verwerkt en in de 3D-ruimte geplaatst. De uitvoer 

is een ruimtelijke fotoscan die de uitlijning van alle foto’s 

weergeeft, waarna deze verder verwerkt kunnen worden. 

Stap 2. 

Model maken 

In deze fase wordt de 3D mesh berekend die vervolgens op 

de gewone manier verder kan worden verwerkt in Artec 

Studio. We kunnen kiezen tussen twee soorten berekeningen: 

1.	 Separate object (afzonderlijk object)

2.	 Whole scene (De volledige scene)

De beide algoritmes berekenen een mesh, maar elk is geschikt 

voor verschillende doeleinden. We raden aan om de twee 

algoritmen onder verschillende omstandigheden en voor 
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verschillende scenes te gebruiken. Hoewel sommige scenes 

door beide algoritmen kunnen worden verwerkt, kunnen andere 

beter door de ene dan door de andere worden afgehandeld.

Separate Object 

Het algoritme voor Separate Object het meest geschikt voor 

het berekenen van verschillende relatief kleine objecten, zoals 

een afstandsbediening, een beeldje, een pen of een stoel. Om 

de kwaliteit van het algoritme voor Separate Object te 

verbeteren, worden er “maskers” gemaakt van iedere foto. Een 

speciaal algoritme detecteert daarvoor de objecten die worden 

bedoeld om te laten berekenen. Voor optimale resultaten 

moet u ervoor zorgen dat het hele object volledig binnen het 

kader wordt vastgelegd en goed gescheiden is van de 

achtergrond. Deze duidelijke scheiding is essentieel voor het 

algoritme om nauwkeurige maskers te maken en mogelijke 

foutmeldingen tijdens de reconstructie te voorkomen.

Whole scene

In deze toepassing is een sterke scheiding tussen het object 

en de achtergrond niet nodig. Deze berekening kan werken 

met of zonder “masker”. Deze berekening is gericht op 

reconstructie van scenes met veel diverse soorten informatie, 

zoals opnames vanuit de lucht met drones, of grote objecten 

zoals stenen, standbeelden, architecturale objecten, enz.

Algemeen overzicht van werkvolgorde

Hieronder is de grote lijn van alle stappen die worden gevolgd 

in dit proces in Artec Studio: 

 

Software installeren 

Om de AI-Photogrammetry te kunnen gebruiken moet Artec 

Studio 19 (en hoger) zijn geïnstalleerd, waarmee u sets foto’s 

of video’s kunt importeren voor het verder berekenen van een 

3D-model. 

Artec Studio 19 (en hoger) moet apart worden aangeschaft. 

Neem hiervoor contact op met 4C in Emmen. Houd er 

rekening mee dat er een internetverbinding beschikbaar moet 

zijn om de software te downloaden en in licentie te geven. 
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1.	 Open my.artec3d.com. 

2.	 Zodra u zich hebt geregistreerd, wijst 4C licentie van  

de software toe aan je account.

3.	 Download Artec Installation Center. 

4.	 Installeer Artec Installation Center op je computer  

en start deze. 

5.	 Klik op Install bij de knop Artec Studio, zoals beschreven  

in de handleiding van Artec Studio. 

6.	 Installatie voltooien.

Het gebruik van “Scale Bar & Cross” 

De “Scale Bar & Cross” kunnen worden gebruikt om ervoor te 

zorgen dat het 3D-model in Artec Studio de juiste afmetingen 

krijgt.  Zonder deze hulpmiddelen zijn de afmetingen van het 

model willekeurig, omdat het systeem gebruik maakt van foto’s. 

Scale Bar 

Met een Scale Bar (een geijkte balk), kun je de juiste schaal 

voor je model verkrijgen door de afstand tussen twee “targets” 

te gebruiken. Hiermee wordt de schaal van een object bepaald 

langs één as. Dit is nuttig voor het bepalen van de afmetingen, 

maar geeft ons geen informatie over de 3D-oriëntatie in de 

ruimte. 

Scale Cross 

De “Scale cross” - het kruis op de afbeelding – geeft ons 

naast de afmetingen ook de positie en de oriëntatie in de 

3D-ruimte. Het bestaat uit twee elkaar kruisende Scale Bars. 

Deze uitgebreide referentie is nuttig wanneer u zowel de 

grootte als de oriëntatie in de ruimte wilt vastleggen. 

Als u geen “Scale bar & Cross” heeft, dan is het mogelijk een 

geprinte versie gebruiken. Deze is beschikbaar als PDF-

document op uw eigen computer: C:\Program Files\Artec\

Artec Studio [versie] Het bestand is ASC A4.pdf. 
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	 Opmerking

	� De absolute nauwkeurigheid kan hiermee uiteraard niet 

worden gegarandeerd.

Het aanmaken van “Scale references” in 
Artec Studio

Als u de juiste afmetingen van het object wilt vastleggen, dan 

moeten de “Scale references” van de Scale Bar & Cross worden 

ingevoerd in Artec Studio voordat de berekening Create Preview 

wordt gedaan. Open hiervoor het dialoogvenster voor het 

maken van “Scale references” in Artec Studio. 

Er zijn hiervoor twee mogelijkheden: 

1.	 Ga naar File › Coded targets and scalebars.

2.	 Selecteer een fotoset in Artec Studio.  

Ga dan naar Tools › AI Photogrammetry › Create Preview 

› Settings. Klik op Edit in Scaled reference.

Het toevoegen van de Scale Bar

1.	 Definieer de ID’s van de targets, de afstand ertussen (in 

millimeters) en de naam van de Scale Bar.  

Houd er rekening mee dat de ID’s uniek moeten zijn en 

moeten vallen tussen 1 en 516. 

2.	 Klik ten slotte op Create reference.  

De nieuw gemaakte Scale Bar verschijnt in de lijst aan de 

linkerkant van het scherm.
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Het toevoegen van de Scale Cross

1.	 Definieer de ID’s van de twee sets targets, de afstand 

ertussen (in millimeters) in elk paar en de naam van de 

Scale Bar.  

Houd er rekening mee dat de ID’s uniek moeten zijn en 

moeten vallen tussen 1 en 516. 

2.	 Klik ten slotte op Create reference.  

De nieuw gemaakte Scale Bar verschijnt in de lijst aan de 

linkerkant van het scherm.

Het maken van goede Foto’s

In Artec Studio zijn er verschillende voorwaardes waaraan de 

foto’s moeten voldoen:  

Voorwaarde 1.

Probeer het te scannen object vast te leggen in een goed 

verlichte omgeving en met name met goed en sterk 

omgevingslicht. De beste lichtomstandigheden zijn door 

buiten foto’s te maken op een bewolkte dag. 

Voorwaarde 2.

Zorg ervoor dat het hele object duidelijk scherp is, zodat er 

geen delen wazig lijken. Is er onscherpte, dan is het raadzaam 

extra licht in de scene te brengen, het diafragma van de lens 

kleiner te maken of een combinatie van beide. 

Voorwaarde 3.

Wanneer je gegevens vastlegt die geschikt zijn voor Create 

Preview (Separate object), moet je ervoor zorgen dat iedere 

foto het hele object vastlegt binnen het kader van de 

camera en is gescheiden van de achtergrond. Maak geen 

foto’s waarbij het grootste deel van het beeld wordt bedekt 

door het object en sommige delen van de achtergrond nog 

zichtbaar zijn, want dit kan de “objectdetector” in de software 
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in verwarring kan brengen. Dit is een deel van de software dat 

in staat is objecten te herkennen in een set van foto’s.  

	 Opmerking

	� in plaats van foto’s kan ook een video van het object 

worden gemaakt, rekening houdend met de hierboven 

genoemde punten. Video’s worden behandeld als een  

set frames en kunnen op dezelfde manier als foto’s in  

Artec Studio worden geïmporteerd.

Goede foto’s voor de verwerking

Slechte foto’s voor de verwerking

01 | Foto’s die de “objectdetector” in verwarring kunnen brengen: 

Verschillende objecten binnen het cameraframe.

02 | Close-ups, wanneer een deel van het object als 

achtergrond kan worden beschouwd.
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02 | Te sterke achtergrond, wanneer een deel van de 

achtergrond als een object kan worden beschouwd.

Voorwaarde 4.

Je kunt meerdere camera’s gebruiken om hetzelfde object 

vast te leggen. Bij het importeren van de foto’s maakt Artec 

Studio (versie 19.2 of hoger) één Foto’s-object voor alle 

afbeeldingen, ongeacht welke camera ze heeft vastgelegd. 

Welke camera kan ik gebruiken? 

Er zijn geen strikte voorschriften voor het maken van foto’s 

met verschillende camera’s van hetzelfde object, maar het is 

wel aan te raden om grote verschillen in het gezichtsveld 

(FOV – field of view) te vermijden. Idealiter is dit verschil niet 

groter dan een factor 7 om te zorgen voor een goed resultaat. 

In sommige scenario’s kan het nuttig zijn om verschillende 

soorten camera’s te gebruiken: 

•	 Drone- en grondfotografie › Het vastleggen van 

luchtfoto’s met een drone en gedetailleerde 

grondopnamen met een gewone camera, zorgt voor een 

uitgebreide dekking van het object. 

•	 Groothoek- en standaardlenzen › Een groothoeklens kan 

efficiënt een algemene scene vastleggen, zoals een hele 

kamer, terwijl een standaardlens kan worden gebruikt om 

gedetailleerde opnamen te maken van specifieke zaken, 

zoals een standbeeld in een kamer.

Voorwaarde 5.

Probeer het object vanuit alle 

richtingen vast te leggen, zodat 

het algoritme gebruik kan 

maken van een grote 

verscheidenheid aan foto’s. Een 

goede gewoonte is om je een 

virtuele bol rond het object voor 

te stellen en te proberen 

beelden vanuit verschillende 

hoeken vast te leggen. 
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Voorwaarde 6.

Het object mag worden omgedraaid en dan een nieuwe set van 

foto’s maken om op die manier een volledige 3D-reconstructie 

te krijgen. Zorg er in dat geval voor dat foto’s van elke object-

oriëntatie als een afzonderlijke fotoset in Artec Studio worden 

geïmporteerd. 

Voorwaard 7.

Als je object geen textuur heeft, zorg er dan voor dat de 

achtergrond dat wel heeft. 

Voorwaarde 8.

Voor Create Preview (Separate object) zijn 50-150 foto’s 

meestal voldoende om een goede kwaliteit 3D object te bereiken.

Video’s

Zorg er bij het opnemen van een video voor fotogrammetrie 

voor dat het hele object altijd volledig zichtbaar blijft binnen 

het kader. Vermijd bovendien het wijzigen van de camerarichting 

tijdens het opnemen (bijv. schakelen tussen portret- en 

landschapsmodus).

Foto’s/video’s importeren

Foto’s/video’s importeren in Artec Studio: 

1.	 Een map met foto’s of videobestanden neerzetten. 

2.	 Je kunt ook het menu Bestand gebruiken via Bestand › 

Importeren › Foto’s en video’s. 

Als een videobestand wordt 

geïmporteerd, maakt Artec 

Studio er een ruimtelijke 

fotoset van. Na import 

moeten we aangeven 

hoeveel beelden per 

seconde er in Artec Studio moeten worden gemaakt. Dit is de 

optie Frames per second in het pop-upvenster Import Video. 

De standaardwaarde is 3. 

Geselecteerde bestanden worden in Artec Studio toegevoegd 

als een nieuwe set foto’s. Videobestanden worden ook 

toegevoegd als afzonderlijke objecten van het type Foto’s.
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De afzonderlijke foto’s bekijken

1.	 Dubbelklik op de fotoset 

(de import) rechts en 

dubbelklik vervolgens op 

een foto om deze te 

openen. 

2.	 U kunt ook met de 

rechtermuisknop op de 

fotoset klikken en de optie 

Fotoviewer selecteren.

3.	 Gebruik de pijlen naar links en rechts in het dialoogvenster 

van de fotoviewer om door de foto’s te bladeren.

Starten van “Create Preview”

Het algoritme voor Create Preview zet geïmporteerde foto’s 

ruimtelijk op de juiste plaats. 

Selecteer de geïmporteerde foto’s. Open het Tools-paneel en 

klik op het tandwielpictogram van Create Preview om het 

instellingenvenster te openen.

Basisinstellingen 

1.	 Scene type › Hiermee kunnen gebruikers het optimale 

algoritme kiezen voor het verwerken van afzonderlijke 

objecten (Objects) of complexe Scenes. 

2.	 Object orientation › Definieert de richting waarin het 

object is gericht, die handmatig kan worden aangepast 

door één van de beschikbare opties te selecteren.

3.	 Optimize for › Kiezen uit twee mogelijkheden: 

optimalisatie voor Speed (snelheid) of Quality (kwaliteit). 

4.	 Scale References / Detect › Hiermee kunt u de werkelijke 

afmetingen van het object bepalen op basis van de 

toegevoegde eerdergenoemde “Scale Bars”. 

Geavanceerde instellingen 

1.	 Object position › 

Specificeert de positie van 

het object ten opzichte 

van de achtergrond. 

-	 Same in all photos › 

kies dit als de positie 

van het object op alle 

foto’s hetzelfde is. 
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-	 Changes between photosets › gebruik deze optie als 

de positie van het object consistent blijft binnen één 

fotoset, maar varieert tussen verschillende fotosets. 

-	 Changes between photos › selecteer deze optie 

wanneer de positie van het object binnen dezelfde 

fotoset verandert.  

Dit is in het geval waarin het object in iedere foto in 

verschillende richtingen ten opzichte van de 

achtergrond verschijnt, zoals bij het gebruik van een 

draaitafel.

2.	 Default FOV › Specificeert het gezichtsveld van de 

camera, dat wordt gebruikt wanneer deze informatie 

ontbreekt of onleesbaar is in de metagegevens van foto’s. 

De standaardwaarde is 60°. 

Max reprojection error 

•	 Frame › geeft de maximaal toegestane afwijking aan voor 

gelijke punten tussen afzonderlijke foto’s. De waarde zegt 

hoeveel de posities van afzonderlijke punten die 

overeenkomen binnen een fotoset mogen variëren. Als 

deze waarde wordt overschreden, dan wordt de foto niet 

meegenomen in de berekening. De standaardwaarde is 

4.000 px.

•	 Feature › gelijk aan Frame, maar nu wordt gekeken naar 

overeenkomende contouren of kleuren. De 

standaardwaarde is 4.000 px. 

•	 Increase feature sensitivity › Vergroot de gevoeligheid van 

het algoritme voor fijne details, die tijdens de reconstructie 

dan beter herkend worden. Dit kan de kwaliteit van het 

model verhogen, maar kan het proces vertragen of de 

eisen, gesteld aan de foto’s, vergroten. 

•	 Target color scheme › bepaalt op welke manier naar 

Targets moet worden gekeken die op het object kunnen 

zijn geplakt: wit op zwart of zwart op wit. 

Zodra de berekening is voltooid, verschijnt er een Photo Scan 

(een 3D puntenwolk) op het scherm. Deze fotoscan is 

gekleurd, zodat je de algemene vorm van je object kunt zien.

Starten van “Create Model”

Voorbereiding

Dubbelklik op het zojuist 

gemaakte Photo Scan-object in 

de lijst rechts en pas eventueel 

de manier van bijsnijden van het 

object aan om de afmetingen van 

het eindresultaat aan te passen. 
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Door dit te doen, worden niet alle ruimtelijke punten gebruikt 

in de berekeningen. Omsluit het object zo nauwkeurig 

mogelijk, maar laat rondom wel enige ruimte. 

Inspecteren van de “Maskers”

De software maakt automatisch maskers aan voor iedere foto. 

Hiermee wordt het object a.h.w. “vrij gesneden”. We kunnen 

de manier waarop de maskers zijn gemaakt bekijken en om 

twee redenen: 

•	 Bij gebruik van Create Model (Separate object). 

•	 Als de resultaten tegenvallen of als het vermoeden bestaat 

dat u zich tijdens de opname niet aan onze richtlijnen heeft 

gehouden. 

	 Opmerking

	� Voor Create Model (Separate object), worden maskers 

consequent gebruikt tijdens het hele proces. 

Inspecteer maskers door met de linkermuisknop op het 

tandwielpictogram te klikken en de maskerweergave in te 

schakelen. Als alternatief kun je sneltoetsen gebruiken voor 

snellere navigatie:

			          › For images

			          › For masks

			          › For masked photos

Zorg ervoor dat de maskers over het algemeen correct zijn. 

Als ze volledig onnauwkeurig zijn, kunnen gebruikers de foto 

uitschakelen via Create Model (Separate object). 

Wanneer je van plan bent Create Model (Whole scene) te 

gebruiken, dan is het gebruik van Masks niet altijd nodig, 

bijvoorbeeld bij het gebruik van drone-data. Ook als je merkt 

dat de meeste maskers erg onnauwkeurig zijn, schakel je 

eenvoudig de optie Use Masks in dit algoritme uit. 

Het handmatig uitschakelen van individuele maskers zal de 

resultaten niet verbeteren. 
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Het kan soms gebeuren dat 

de “objectdetector” het 

object niet kan detecteren 

omdat de scene te complex 

is, of wanneer er extra 

objecten dicht bij het 

gescande object staan. Als 

dit het geval is, laat die foto 

dan niet meedoen in de 

berekening door op Exclude photo te drukken. 

Uitgeschakelde foto’s worden overgeslagen tijdens de 

berekening van Create Model (Separate object).

Selecteer hiervoor een foto en druk op de ‘P’-toets, of gebruik de 

knop in de linkerbovenhoek van de miniatuur van de afbeelding.

Als een masker een deel van het object bevat dat verder gaat 

dan de het gebied dat wordt bijgesneden, dan kan dit mogelijk 

leiden tot artefacten na Create Model. Probeer in dit geval het 

gebied te vergroten zodat alles in de berekening wordt 

meegenomen.

Keer terug naar de werkruimte met behulp van de ‘pijl-links’ 

boven in het venster. Zorg ervoor dat nu alleen de gewenste 

Photoscan is aangevinkt.  

Open Tools en klik op het tandwielpictogram van Create 

Model om het instellingenvenster te openen. 

Create Model (Separate 

object) settings

Scene Type › Kies het optimale 

algoritme voor het berekenen 

van kleinere objecten of 

complexe scenes. 

Bij een object dat op iedere foto 

goed gescheiden is van de 

achtergrond, kies dan Scene 

Type Object. 

•	 Detail › Kies tussen de opties Normal en High. In de 

meeste gevallen is de optie Normal voldoende. Gebruik de 

optie High als er extra detailniveau of een betere 

reconstructie van kleine en dunne structuren van het 

object nodig is. De optie High kan resulteren in een meer 

gedetailleerd model maar ook met meer ruis. De 

berekening duurt ook langer.  
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•	 Use sparse point cloud › Gebruikt vooral ruimtelijke punt-

data bij het reconstrueren van gekromde delen en het 

uitsnijden van gaten waar nodig. Voor sterk reflecterende 

objecten kan het echter artefacten introduceren, zoals 

ongewenste gaten in het oppervlak, dus het is raadzaam 

om deze optie uit te schakelen en de reconstructie 

opnieuw te proberen als er zich problemen voordoen. 

•	 Make object watertight › schakelt tussen het opvullen van 

gaten in een model of niet. Artec Studio maakt het mogelijk 

om ook later de gaten op te vullen. 

•	 Show preview › Inschakelen van een realtime preview 

tijdens de berekening van het model.

Model maken (hele scene) 

Bij het reconstrueren van zeer grote scenes of objecten, 

kiezen we voor Whole scene door de optie Scene Type te 

wijzigen in de Scene (Beta). 

Hier kunt zijn verschillende parameters te wijzigen: 

•	 3D-resolutie › definieert de gladheid van het resulterende 

oppervlak. 

•	 Depth map resolution › bepaalt de maximale 

afbeeldingsresolutie tijdens het berekenen van het model. 

Hogere waardes geven een hogere kwaliteit maar ook een 

langere rekentijd. 

•	 Depth map compression › Maakt compressie van 

dieptekaarten zonder verlies mogelijk, wat berekeningen 

kan vertragen wegens extra verwerkingstijd voor 

compressie en decompressie. Het vermindert echter het 

gebruik van schijfruimte, waardoor het gunstig is voor 

systemen met trage schijven (HDD of netwerkopslag).

•	 Use Masks › bepaalt of er wel of niet maskers moeten 

worden gebruikt tijdens de berekening. Dit kan de snelheid 

en kwaliteit aanzienlijk verbeteren, maar moet worden 

uitgeschakeld voor grote objecten en luchtopnames.
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Project masks

Vanaf Artec Studio 19.2 is de functie Maskers beschikbaar. 

Deze functie verbetert de nauwkeurigheid van de berekening 

van de 3D-mesh door gebruik te maken van maskers die zijn 

gemaakt op basis van de registered preview (Photo scan). 

Deze tool is met name handig wanneer de eerste masker-

detectie tijdens de Create Preview berekening mislukt of 

onnauwkeurige resultaten oplevert. Door nieuwe maskers op 

het gemaakte 3D-model te projecteren, kunnen gebruikers 

ongewenste details, zoals achtergrondelementen, uitsluiten 

en een schoner, nauwkeuriger 3D-model genereren.

Typical use case

1.	 Bereken Create Preview om een Photo scan te verkrijgen. 

2.	 Zoek onnauwkeurige of foute maskers bij bepaalde foto’s 

en Ëxclude” deze foto’s. 

Hoe deze maskers UIT-zetten: 

-	 Dubbel klik op de berekende Photo scan in het venster 

Rechts. 

-	 Klik op een masker dat je wilt uitschakelen of Shift-klik 

om meerdere maskers te selecteren. 

-	 Rechts-klik op de geselecteerde maskers.  

-	 Selecteer de Disable mask optie.  

3.	 Bereken Create Model om een 3D model te verkrijgen. 

4.	 Projecteer maskers op de uitgeschakelde foto’s.  

Maskers projecteren: 

-	 Zorg dat het berekende 3D model en de Photo scan 

zijn aangevinkt.

-	 Dubbel klik op de Photo scan.  

-	 Zet de maskers weer AAN bij de eerst uitgeschakelde 

foto’s door te klikken met de rechtermuisknop en kies 

Enable mask. Moet je maar één foto doen, klik dan op 

het vierkantje rechtsboven de foto. 

-	 Bekijk alle andere maskers en kies dan Project masks in 

het context menu met de rechtermuis klik. 

5.	 Laat het 3D model nogmaals berekenen met de verbeterde 

kwaliteit door Create Model nogmaals te laten rekenen.

Voorbeeld van maskers voor en na.
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Aanvullende richtlijnen: Beperkingen 

Hier een aantal beperkingen en kanttekeningen die van 

belang zijn: 

1. De snelheid berekenen is een verbeterpunt. 

We raden nu aan om geen grote datasets (meer dan 1000 

foto’s) te verwerken in de huidige versie van Artec Studio. 

•	 De tijd die nodig is voor het Separate Object algoritme is 

niet afhankelijk van het aantal foto’s in de dataset, maar is 

afhankelijk van: 

-	 De gebruikte videokaart (moderne NVIDIA-kaarten zijn 

vereist). 

-	 Het gekozen profiel: Normal of High resolutie. Deze 

laatste is 1,5 tot 2 keer langzamer. 

•	 De tijd die nodig is voor het berekenen van het Create 

Model (Whole Scene) algoritme, is afhankelijk van: 

-	 Het aantal foto’s. 

-	 De Videokaart, SSD-snelheid en CPU van je computer. 

-	 De gekozen resolutie. 

2. Vereisten voor grafische kaart: 

•	 We raden ten zeerste aan om een moderne NVIDIA-kaart 

te gebruiken (andere grafische kaarten worden niet 

ondersteund). 

•	 We raden ten zeerste aan om ten minste 8 GB video-RAM 

te hebben. 

•	 We raden ten zeerste aan om de stuurprogramma’s van je 

grafische kaart bij te werken. 

•	 De standaardduur voor het algoritme voor afzonderlijke 

objecten varieert doorgaans van 10 tot 30 minuten bij 

gebruik met de normale resolutie. 

3.	Vereisten voor schijf 

•	 Tijdens het Create Model (Whole Scene) is er veel 

schijfruimte nodig om de gegevens te verwerken. De 

benodigde hoeveelheid schijfruimte is afhankelijk van de 

resolutie van de foto’s en de geselecteerde resolutie. Dit 

deel kan ongeveer – 15 GB schijfruimte per 100 foto’s in 

beslag nemen. Het wordt ten zeerste aanbevolen om 100 

tot – 200 GB vrije schijfruimte te hebben op de schijf 

waar de Artec Studio Temp-map zich bevindt. 

•	 Wanneer je een tekort aan vrije ruimte op je systeem onder- 

vindt, aarzel dan niet om wat ruimte vrij te maken door te 

klikken op de knop Tijdelijke bestanden van Artec Studio 

wissen op het tabblad Algemeen van Instellingen (F10). 
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•	 Toch is het raadzaam om je Temp-map in de instellingen 

van Artec Studio in te stellen op de schijf met de hoogste 

snelheid en voldoende vrije ruimte. 

Als je de map Temp wilt instellen, open je Instellingen (F10) en 

blader je naar de nieuwe bestemming.

 

Troubleshooting

Algemene verwerkingsfout

Suggested Remedies Possible Cause(s)

Zorg dat modellen correct zijn Zorg dat modellen correct zijn 
berekend voordat je verder gaat 
met de bewerkingen. 
Klik op Set up neural network in 
the Create Preview berekening of 
doe dit via Settings › Performance › 
Neural Network Setup.

Problemen met fotoregistratie

Suggested Remedies Possible Cause(s)

Onvoldoende foto’s of foto’s met 
een slechte overlapping van de 
beelden.

Maak meer foto’s met goede 
overlapping voor een juiste 
berekening.

Object van te dichtbij 
gefotografeerd (teveel close-ups).

Zorg voor een goede afstand tussen 
de camera en het object zodat het 
complete object binnen het beeld 
valt.

Object gespiegeld of verdraaid 
zonder dat hiervoor opdracht is 
gegeven in de settings.

Zorg dat de Object Position setting 
voor alle foto’s gelijk is.

Onvoldoende beeld als model 
verdraaid wordt.

Zorg voor voldoende foto’s vanuit 
iedere kijkrichting met ruime 
overlap! 
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Masker problemen

Suggested Remedies Possible Cause(s)

Meerdere objecten zichtbaar op 
één foto.

Zorg dat alleen het object dat je wilt 
berekenen zichtbaar is op de foto’s. 
Gebruik mask projection om de 
maskers handmatig te verbeteren.

Close-up foto’s maken het verschil 
tussen object en achtergrond 
lasting.

Houd voldoende afstand zodat het 
verschil tussen het object en de 
achtergrond duidelijk te zien is op 
de foto’s. 

Drukke achtergrond zichtbaar in 
maskers.

Zorg voor een rustige, schone en 
uniforme achtergrond om invloed 
op de maskers te voorkomen.

Target detectie problemen

Suggested Remedies Possible Cause(s)

De Scale bar of het kruis is niet 
goed zichtbaar in de foto’s. 

Zorg dat de targets goed belicht 
zijn en in alle foto’s zichtbaar. 

Targets deels verborgen of slecht 
op de foto staan.

Zorg dat de targets zichtbaar zijn en 
goed verdeeld worden over het 
totale object. 

Slechte kwaliteit van de foto’s

Suggested Remedies Possible Cause(s)

Overbelichte of onscherpe foto’s. Zorg voor de juiste instellingen van 
de camera en voor de juiste 
belichting. Veel scanplezier met  

ARTEC PHOTOGRAMMETRY



4C Creative Cad  
Cam Consultants

4C Creative CAD CAM Consultants is een bedrijf dat 

gespecialiseerd is in 3D-technologieën en gevestigd is  

in Emmen, Drenthe. 4C is uw partner voor het leveren  

van professionele hardware en software voor 3D-scannen, 

reverse engineering, AR & VR en kwaliteitscontrole.

Contact

		  info@4cccc.nl

		  +31 (0)591 - 377 442

4cccc.nl
Uw partner voor het kopen van 

een Artec 3D scanner in de Benelux

Voor meer informatie, faq, updates,  

documenten en video’s over Artec Photogrammetry

ga naar 4cccc.nl/kennisbank/artec-photogrammetry

https://4cccc.nl/
mailto:info%404cccc.nl?subject=
https://4cccc.nl/kennisbank/artec-photogrammetry/

